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II.il'RI}TU.tr'RE .tr.tsl}
RE(IIIIREMENTS
Iffind.orrvs@ wersion
Rrrrts on:
r IBM@ and compatibles-

386DX/33 MHz or better

tTith;
I 4 MB available memory (RAM)

r Hard disk with 1.2 MB free disk
space

r Double-speed CD-ROM drive

r Color monitor

r 256-color SVGA

r DOS 5.0 or higher

r Windows 3.1 running in 386
Enhanced Mode

I Sound Blaster'"'. Microsoft@, or
other Windows-compatible sound

card

I Mouse

SYSTEItI

Il/Iacintosh@ rrersiorr
Rrrrrs orr:
r All color Macintosh computers,

including Color Classic@, Color
Classic II; LC series (except original
LC); II series (except II); color
PowerBook"' series; Centris'" series;

Quadra'"' series; Quadra AV series;

Performa'^' series (except Performa
200); and Power Macintosh'"' series

Itrith:
r 4 MB available memory GAM)

(System 7'"'Virtual Memory is not
supported.)

r Hard disk with 1.2 MB free
disk space

I Double-speed CD-ROM drive

I 256-co1or monitor

I System 7.0.1 or higher

r Mouse

SETTIIuG UP.tr,NI} s|T.tr,RTING TIIE
PR(}GR.tr.It[-tulND(}ItrS

Super Solvers OutNumberedl runs from your CD-ROM drive. However, a

program file and your saved games will be stored on your hard disk. The

setup program will automatically create two directories (storage areas) on

your primary hard disk (C: drive). One is called TLCWIN. The other, a

subdirectory within the first one, is called SSOWINCD.

You must stafi OutNumbered! from your Windows desktop.

Windorrrs 3.I
To set up the program:

1. At the DOS prompt, type WIN and press ll Entel to stafi Windows.

2. Insert the OutNumberedl CD into your CD-ROM drive.

3. From the File menu, choose Run....

4. Type D:\SETUP (or substitute for D the letter of the CD-ROM drive
you are using) in the Command Line box. Then press JJ EntEl .

5. Follow the instructions on the screen to complete the setup process.

The setup program creates a program group called The Learning



Company on your Windows desktop and places an OutNumbered!
CD program icon within that group.

To start the program:

I Open the program group called The Learning Company and double-
click on the OutNumbered! CD program icon. The OutNumbered!
CD must be in the same CD-ROM drive as in step 2 above.

IUind,ours 95
These instructions assume that the AutoPlay feature of Windows 95 is

turned on. (This feature is usually enabled when you install Windows 95

onto your computer. For more information about AutoPlay, refer to your

Windows documentation.)

To set up and start the program:
1. Make sure Windows 95 is fully launched and running on your

computer.

2. Insert the program CD into your CD-ROM drive. After a brief
delay (5-20 seconds), a dialog box appears.

3. Click on lnstall.

4. Follow the instructions on the screen to complete the setup process.

5. Click on the Start button. Choose Programs from the Starl menu.

Next choose The Learning Company. Then choose OutNumbered!

Once you've completed the setup, OutNumbered! wlll run automatically

any time you insert the program CD into the CD-ROM drive.

To start the program:
1. Make sure Windows 95 is fully launched and running on

your computer.

2. Inserl the program CD into your CD-ROM drive. After a brief
delay (5-20 seconds), a dialog box appears.

3. Click on PIay.

TIPS f{oR RIINI$ING TIIE PR1t}GR.il'It[

I Make sure you are in 386 Enhanced Mode.

I To run OutNumbered! , yow computer must have at least 4 MB of
memory GAM) free before stafiing the program.

I OutNumberedl is designed to be played in 640 x 480 display mode.

For optimal performance, make sure this setting is selected.

I Make sure the sound-card drivers provided by the manufacturer of
your sound card have been installed.

I For best performance, do not run other programs, especially ones that

use sound, while running OutNumbered!



TR{oIIBI.Eslll{t}{t}TING-TUINI}(}tuS

Try this first! If you have problems running the program, try cleaning the

CD. Gently remove any fingerprints and dust using a clean, soft,
lint-free cloth dampened with water or a CD-cleaning solution. Avoid
using materials such as tissue, which may scratch the CD.

When you try to start the program, you see a message that there
is not enough memory available to run OutNumbered!
Your computer's memory (RAM) may be filled with other programs

that are currently running. OutNumberedl requires at least 4 MB of
free memory (RAM) in order to run. Try to increase the available
memory and then start OutNumbered! again.

. Close any other applications that are running.

. Turn on Virtual Memory. (We recommend that you create
at least 4 MB of virtual memory. See your Windows
documentation for information.)

. If you have DOS 6.0 or higher, you can run the MemMaker utility
to free up more conventional memory.

When you try to start OutNumbered!,you see a message that
there is not enough room on the hard disk.

The file called SSOWINCD.DAT, which contains your player

information, has been moved or deleted, and you do not have enough

hard disk space to create a new one. OutNumberedl requires at least

600K offree space on your hard disk to create a new player

information file. Compress some files on your hard disk, or remove

some after backing them up.

The game action and/or digitized speech is very slow.

If you have a 386DX or less powerful machine, a computer running

slower than 33 MHz, or a single-speed CD-ROM drive, the game

action and/or digitized speech will be s1ow. OwtNumbered! requires at

least a 386DX 133 MHz machine with a double-speed CD-ROM drive

for basic performance.

The names are missing from the Sign-In list.
The SSOWINCD.DAT file may have been deleted or removed from the

SSOWINCD directory or the directory you specified at installation.

. Find the missing file and place it in its directory on your
hard disk.

. If the file was not found, another SSOWINCD.DAT file has

already been created. However, the new file does not contain the

o1d players' names or their scores.

3.

4.
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5. Your mouse doesn't work.
A mouse driver program must be correctly installed in your
Windows setup.

. Restart Windows, making sure the mouse driver program
is correctly loaded. See the documentation that came with your
computer or mouse for instructions.

You do not hear sound, music, or speech.
. Check that your speakers are properly connected to your

computer, getting power (have good batteries and are plugged in),
turned on, and that the volume is turned up.

. Make sure that Sound Effects, Music, and Voice are turned on.

(Go to Sound at the Options menu.)
. Make sure that your sound card is Windows compatible, properly

installed for Windows, and supports voice, and that the MIDI
Mapper is properly configured. See your sound-card
documentation for instructions.

. Check the volume control on your sound card.

. Make sure the volume is turned on from your sound card's mixer.

. Make sure that you do not have an IRQ or DMA conflict between
your sound card and other add-on peripherals. (Consult the

documentation for your sound card, CD-ROM drive, and other
add-on peripherals.)

. Close other applications, especially those that use sound.

7. Strange graphics appear on screen.
. Try using the 640 x 480 256-color display mode driver that came

with your video card. (See your Windows documentation for
information.)

. Make sure you have the latest video card drivers installed. Contact

your video card manufacturer for more information.

Colors don't look right.
. Close other programs that use 256 colors.
. Try turning off your screensaver.

The game window is too small.
. Make sure that the display mode is set to 640 x 480. Consult your

Windows documentation for assistance.

If you have questions, call our Technical Support
Center at 423' 67 0 -2020.

You can also reach us by e-mail: support@learningco.com.

For more information about The Learning Company, Inc.,
visit our World Wide Web site: http://www.learningco.com.

6.

8.

9.



SETTING IIP.il,ISD ST.ERTING TIIE
PRt[}GR.tr'Itfi-nr.r'GINTtrSII

Super Solvers OutNumberedl runs from your CD-ROM drive. However, a

program file and your saved games will be stored on your hard disk. Your
saved games will be in a file called OutNumbered! CD Prefs, which will
be stored in the folder called The Learning Company in the Preferences
folder in the System Folder.

To set up the program:

1. Insert the OutNumberedl CD into your CD-ROM drive.

2. Double-click on the Installer icon in the open window called
OutNumberedl CD. The OutNumbered! lnstaller welcome screen
appears. Click on OK to continue. After a few moments, the
installation dialog box appears.

3. Make sure the drive selected is the one you want to use for the
installation. Click on lnstall. Click on Yes to install Sound
Manager 3.0. (This Apple extension changes how the system handles
sound and improves the program's sound quality.) Follow the
instructions on the screen to complete the installation.

10

You must start Super Solvers OutNumbered! from your CD. Make sure you
quit any other applications that use sound before starting OutNumbered!

To start the program:

1. Make sure the OutNumbered! CD is in the same CD-ROM drive as

in step 1 above.

2. Double-click onthe OutNumbered! CD icon in the open window
called OutNumbered! CD.

TROIIBI.ESIIO1oTIlsG-Il[.5'GINT(}SII
Try this first! If you have problems running the program, try cleaning the
CD. Gently remove any fingerprints and dust using a clean, soft,
lint-free cloth dampened with water or a CD-cleaning solution. Avoid
using materials such as tissue, which may scratch the CD.

l. You do not see the OutNumbered! CD icon.
. Make sure the CD is inserted in the CD tray, printed side up.
. Try restarting your computer.
. Make sure that the CD-ROM extensions are correctly installed.

ll



4.) During the startup process, you see a message that there is not
enough room on the hard disk.
You must have 1.2 MB of space available on your hard disk for
the program's data folder.

. Turn off Virtual Memory in Control Panels.

. Compress some files on your hard disk, or remove some
after backing them up.

You get a message telling you there is not enough memory to run
OutNumbered!
OutNumberedl requires 4 MB of available system memory (RAM) to
run. Try to increase available memory and then stafi OutNumbered!
again.

. Quit any programs that you may be running.

. Turn off or remove from your System Folder all non-Apple control
panel devices (CDevs) and INITS. (Leave your CD-ROM
extensions on.) Then restart your computer.

Reduce the size of the disk cache in the Memory control panel.
(See your Macintosh documentation.)

Turn off AppleTalk@ in Chooser.

Program speed is very slow or the game freezes.
OutNumberedl needs a double-speed CD-ROM drive to run.

. Turn off Virtual Memory in Control Panels.

. Increase the size of the disk cache in the Memory control panel.
(See your Macintosh documentation.)

The names are missing from the Sign-In list.
The OutNumbered! CD Prefs data file may have been deleted or
removed from the Preferences folder in the System Folder.

. Find the missing file and place it in the folder called The Learning
Company in the Preferences folder in the active System Folder on
your hard disk.

. If the file was not found, another OutNumbered! CD Prefs file has

been created. However, the new file does not contain the old
players' names or scores.

The program does not update the player information on the
Sign-In screen after you play a saved game or does not allow you
to add a new player name.
. Click once on the OutNumbered! CD Prefs file (in the folder called

The Learning Company in the Preferences file in the active System
Folder) to highlight it. Choose Get lnfo from the File menu. If the

\
/s.

3.
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7.

8.

"Locked" box is checked, click on Locked to uncheck the box.

Restart OutNumbered!

The music in the game is too loud or too soft.
. Choose Control Panels. Then choose Sound and adjust your

system's speaker volume as needed.

There is no music, sound, or voice.
Make sure that:

. Sound Effects, Music, and Voice are turned on. Go to Sound at the

Options menu.

. If Sound Manager 3.0 is installed, it is in the Extensions folder in
the active System Folder.

The help balloons from System 7 interfere with the game.
. Click on the balloon icon on the right side of the menu bar.

Then choose Hide Balloons.

If you have questions, call our Technical Support
Center at 423 - 67 0 -2020.

You can also reach us by e-mail: support@learningco.com.

For more information about The Learning Company, [nc.,
visit our World Wide Web site: http://www.learningco.com.

PI..tr.YING TIIE GI[,II[E
Can you find the Master of Mischief's hideout and stop his takeover of
SGTV before it's too late?
Morty Maxwell, the Master of Mischief, is hiding out in one of the rooms
at the Shady Glen TV stationl But which one? Your job is to find out
before midnight. You'Il need to explore the TV station, collect clues
about each room by trying to solve math challenges, capture pieces of
secret code, and outsmart the Master of Mischief. Watch out! With his
assistants, Telly the robot and LiveWire, Morty has yoL:' outnumberedt
But when you use your math and problem-solving skills, you can outwit
the Master of Mischief and find his hiding place!

For a quick start:

Are you ready to begin looking for the Master of Mischief? Here are

some steps to get you on your way!

l. For instructions on starting OutNumbered! , refer to the appropriate
section titled Setting Up and Starting the Program.

At the Sign-In screen, add your name to the list, or choose your name
from the list,

Click on Start Game to begin playing a full game. Click on Drill for
Skill if you just want to answer Telly's drill questions and brush up
on your math facts.

9.

)

3.
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The Garne PIan
Explore the TY station for room clues and pieces of secret code:

I Look for math challenges by moving up to maps, charts, monitors,
and other objects you see in the rooms. Then collect room clues by
trying to solve the math challenges.

I Zap Telly with energy from your zapper. If Telly's belly is lit, Telly
will give you drill questions. Answer them correctly to capture pieces
of secret code.

Drill question

Click on the
calculator keys
to use the
calculator.

Click here to
return to the
TV station.

16 11

Figure out where the Master of Mischief is hiding:

I Use your decoder to study the room clues and pieces of secret code

you've collected.

r Use the Match RuIe to match the room clues to the pieces of secret

code. Then decide which room is the Master of Mischief's hideout!

Room cluesPieces of
secret code

Click here to
return to the
TV station.

Click here
to see the
Match Bule.

Click here
to make a
decision.



The Galerrlator
After you've figured out how to solve a math challenge, you can use your
calculator to help you find the answer.

Press [Q to
clear the
last number
typed in.

Press

[EntErlto
enter your
answer.

Press @ to calculate
the answer to the math
problem you typed in.

Displays the number(s)
you type in; displays the
answer after you press p.

Press f to divide
the number
displayed by the
next number you
type in.

Press I to multiply
the number
displayed by the
next number you
type in.

Press f to subtract
the next number
you type in from the
number displayed.

Press f to add the
next number you
type in to the
number displayed.

18 r9

Tips for Pla5ring tlre Garne
I Watch the clock and energy meter. The clock starts at 9:00 p.na. At

midnight, your time is up. The energy meter starts half full. When the

energy in your zapper gets low, solve a math challenge and get more

energy at the energy supply machine.

I Earn points by solving math challenges, answering Telly's drill
questions, keeping extra energy in your zapper, and finding the Master

of Mischief's hideout before midnight.

I Keep an eye out for onscreen hints that will give you helpful advice

on how to play the game.

Using th.e l5eSrboard

E o.E
E

EEo'EE

Lets you move left or right.

Opens a door; uses the elevator; gets energy;

moves you up to a math challenge; lets you
jump up when Telly throws something at

you.

Lets you flip and move left or right quickly;
lets you leap over Telly and LiveWire.



E Enteil(windows)
or frer-turn I (Macintosh)

tSpace6aal

@tro'BE
trac[spacA or ldeletel

leGar.] orQ

IEsc I or tE]rc]

Removes new player hints from the screen;

chooses any onscreen buttons that are

highlighted; enters the answer to a math
challenge or drill question; enters a name
you type in.

ZapsTelly and LiveWire and makes them
disappear temporarily; when Telly's belly is
lit up. makes math drill queslions appear:

lets you skip opening sequence.

From the station, chooses Decoder; from
the decoder or Telly's belly in the full
game, chooses Station; cycles highlight
between onscreen buttons in the decoder.

Turns all sound off or on.

Erases the last letter, number, or symbol
you typed in.

Clears all the numbers and symbols you
typed into the calculator.

Lets you stop the game and quit the
program.

20 21

Using the Dlorrse
Click and hold down the mouse button in the direction you want to move.

An onscreen arrow points the way you will move.

To use your zapper, click below and to the left or right of you. The arrow
changes to a ball.

Move up

tFlip and
move left

Move left (.

Zap Io
the left

Flip and

a move right

+ Move right

o
Zap lo
the right

(



TIIE LEfi,RIuING GOIIIP^tr,ISY
LICEI$SE II'GREEIiIENT

SINGLE-USER PRODUCTS

This is a legal agreement between you (either an individual or an entity) and The Learning
Company, Inc. ("The Learning Company"). BY OPENING THE SEALED PACKAGES
CONTAINING THE DISKS OR BY USING THE SOFTWARE, YOU AGREE TO BE
BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO THE
TERMS OF THIS AGREEMENT. AND YOU ARE THE ORIGINAL PURCHASER OF
THE SOFTWARE, PROMPTLY RETURN THE SOFTWARE (INCLUDING PRINTED
MATERIALS) TO THE PLACE WHERE YOU PURCHASED THEM FOR A FULL
REFUND.

THE LEARNING COMPANY SOFTWARE LICENSE

GRANT OF LICENSE. This License Agreement permits you to use one copy of The
Learning Company software (the "Software"), which may include electronic
documentation, on a single computer/workstation. The Software is "in use" on a computer
when it is loaded into the temporary memory (i.e., RAM) or installed into permanent
memory (e.g., hard disk, CD-ROM drive, or other storage device) of that computer. You
may lq{ use the software on or over a network or any other transfer device without each

concurrent user having an original copy of the Software and its documentation.

COPYRIGHT. Ali intellectual property rights in the Software (including all animations,
audio, images, maps, music, photographs, video, and text incorporated into the Software)
are owned by The Learning Company and its affiliates, suppliers, and licensors, and are
protected by United States copyright laws and international treaty provisions. The Learning
Company and its affiliates, suppliers, and licensors retain a1l rights not expressly granted.

22 23

You must treat the Software like any other copyrighted material, except that you may

either make one copy of the Soflware solely for backup or archival purposes or transf'er

the Software to a single hard disk provided you keep the original sole1y for backup or
archival purposes. You may not copy the printed materials accompanying the Software.

You may lolL 1oan, rent, or lease the Software, but you may transfer your rights under this

Agreement on a permanent basis provided you transfer the license granted by this

Agreement, the Software and all associated printed materials, and retain no copies, and

the recipient agrees to the terms of this Agreement. You may not reverse engineer'

decompile, or disassemble the Software, except to the extent that this restriction is

expressly prohibited by applicable law. You may not distribute printed copies of any user

documentation provided in electronic format. The restrictions contained herein apply
equally to hybrid CD-ROMs which may contain multiple versions of the Software for use

on different operating systems. Regardless of the type of media you receive, you may use

only the portion appropriate for your single-user computer/workstation.

LIMITED WARRANTY

LIMITED WARRANTY. The Learning Company and its affiliates, suppliers, and

licensors warrant that the media on which the Software is distributed are free from defects

in materials and workmanship fbr a period of ninety (90) days from the time of receipt.

ANY AND ALL OTHER IMPLIED WARRANTIES WITH RESPECT TO THE
SOFTWARE AND THE ACCOMPANYING WRITTEN MATERIALS, INCLUDING
BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED TO NINETY (90) DAYS.

REMEDIES. Your exclusive remedies shall be, at The Learning Company's sole option,
(a) the refund of the amount you paid for the Software or (b) repair or replacement of the

Software provided that (i) the defective Software is returned to The Learning Company or
an authorized dealer within ninety (90) days from the date ofpurchase and (ii) you have

completed and returned the enclosed registration card. This Limited Warranty is void if
failure of the Software has resulted from accident, abuse, or misapplication. Any



replacement Software will be warranted for the remainder of the original warranty period
or thirty (30) days, whichever is longer.

LIMITATION OF LIABILITIES. IN NO EVENT WILL THE LEARNING COMPANY
OR ITS AFFILIATES, SUPPLIERS, AND LICENSORS BE LIABLE FOR ANY
INDIRECT, SPECIAL, INCIDENTAL, ECONOMIC, COVER, OR CONSEQUENTIAL
DAMAGES ARISING OUT OF THE USE OF OR INABILITY TO USE THE
SOFTWARE, USER DOCUMENTATION, OR RELATED TECHNICAL SUPPORT,
INCLUDING, WITHOUT LIMITATION, DAMAGES OR COSTS RELATING TO THE
LOSS OF PROFITS, BUSINESS, GOODWILL, DATA! OR COMPUTER PROGRAMS,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT
WILL THE LEARNING COMPANY'S AND ITS AFFILIATES" SUPPLIERS" AND
LICENSORS' LIABILITY EXCEED THE AMOUNT PAID BY YOU FOR THE
SOFTWARE,. BECAUSE SOME JURISDICTIONS DO NOT ALLOW THE
EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR
INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

U.S. GOVERNMENT RESTRICTED RIGHTS

U.S. GOVERNMENT RESTRICTED RIGHTS. The Software and user documentation is
provided with RESTRICTED RIGHTS AND LIMITED RIGHTS. Use, duplication, or
disclosure by the Government is subject to restrictions as set forth in subparagraph
(c)(l)(ii) of the Rights in Technical Data and Computer Software clause at DFARS
252.22'7-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software-
Restricted Rights at 48 CFR 52.221-19, as applicable. The Learning Company, Inc., One
Athenaeum Street, Cambridge, MA 02142.

IMPORTANT NOTE: In order to receive technical support and notification of product
upgrades and enhancements, please register this product.
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